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Introduction

Audience

The audience for this document is network administrators who wish to deploy a Catalyst 9000 series switch at a branch or
campus using Cisco DNA Center.

About The Solution

Cisco DNA Center can help automate with built-in Plug-and-Play (PnP) functionality and allow switches, routers, and wireless
access points to be on-boarded to the network. An agent in the device, call-home Cisco DNA center and downloads the required

software and device configuration.

About This Guide

This guide will only focus on how to deploy a single non-fabric switch using Cisco DNA Center to help reduce the cost, remove
complexity, and maximize productivity resulting in an overall savings in operational expenses. You may apply this procedure to
any Catalyst 9000 series switch but in this guide, we will only focus on Catalyst 9300 switch.

Reader tip

For more information on Cisco DNA Center supported devices please refer to the compatibility matrix information
https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-center/products-device-support-tables-list.ntml

Use Cases

Following are the two use cases covered within this guide:
e Automate day-zero onboarding of a switch with Plug and Play (PnP).

o Simplified process for Return Material Authorization (RMA).
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Figure 1.
Implementation Flow
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This document contains four major sections:

o The Define section presents a high-level overview of the campus LAN which will be designed and deployed through Cisco
DNA Center.

o The Design section discusses the creation of the site hierarchy within Cisco DNA Center; configuration of various network
services necessary for network operations.

o The Deploy section discusses discovery of the switch in a campus LAN; Define Golden image for a device in inventory,
Create Onboarding Template, Create Network Profiles for Switching, Assign Network Profile to Site, Discover and manage
network devices and Return Material Authorization (RMA).

o The Operate section briefly discusses the known caveats of device onboarding using PnP and RMA.
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Define

Solution overview
Cisco DNA Center can help with the non-fabric wired deployments in various different ways such as — network discovery,
network inventory, management of software revisions, Return Material Authorization, etc.

Reader tip

This guide only covers day-zero onboarding of a switch with Plug and Play (PnP) and Return Material Authorization (RMA). For software
image management (SWIM) refer to Campus Software Image Management Using Cisco DNA Center Deployment Guide.

Figure 2.
Campus Topology highlighting device onboarding in Access layer.
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Cisco DNA Center is designed for intent-based networking (IBN). The solution breaks the process in to Day 0 and Day N. The
solution provides a unified approach to provision enterprise networks comprised of Cisco routers, switches, and wireless devices

with a near zero touch deployment experience.
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When planning to provision any project, the PnP feature within Cisco DNA Center can help pre-provision and add devices to the
project. This includes entering device information and setting up a bootstrap configuration, full configuration, and Cisco device
image for each device to be installed. The bootstrap configuration enables the PnP Agent, specifies the device interface to be

used, and configures a static IP address for it.
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I ——————————
Design
Before you proceed you must make sure you already have Cisco DNA Center installed on your network.

Reader tip

For more information on how to install Cisco DNA Center, refer to Software-Defined Access Management Infrastructure

Prescriptive Deployment Guide.

Cisco ISE is not required for the use cases covered in this guide.

Complete the following prerequisites before proceeding:
e Configure the site hierarchy within Cisco DNA Center

e Configure network services (ex. DNS, DHCP, etc.) necessary for network operation

Process 1: Configure the site hierarchy within Cisco DNA Center

Configuring the site hierarchy involves defining the network sites for the deployment, and their hierarchical relationships.
Network sites consist of areas, buildings, and floors. Their hierarchical relationship is important because child sites
automatically inherit certain attributes from parent sites. However, these attributes may be overridden within the child site.

The following are the procedures for configuring the site hierarchy for this design and deployment guide:

e Create an area.
e Create buildings within the area.

e Create floors within each building and import floor maps

Create an area

Step 1. Login to the Cisco DNA Center. (For example: dnac.company.com)

Tech tip

If SSL is not configured a warning indicating the connection is not secure will appear. For setup purpose you can continue by clicking on
Advanced button and click the link to proceed to Cisco DNA Center webpage.

Also, the credentials (userid and password) you enter must have SUPER-ADMIN-ROLE OR NETWORK-ADMIN-ROLE privileges.

Step 2.  Navigate to Design > Network Hierarchy.

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM
Network Hierarchy Network Settings v Image Repository Network Profiles Authg
=Q | rck e Add Site &"J Import

Step 3. Click Add Site
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Step4. Select Add Area from drop-down menu.

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM
I
Network Hierarchy Network Settings v Image Repository Network Profiles Authentication Template
=Q erar e Add Site @ Import

v ¢ Global Fos Add Area I
i

W Add Building ‘
Add Floor

& Costa Rica

Step 5. Inthe Add Area pop-up window, type in the Area Name and select Parent.

Add Area X |

Area contains other areas and/or buildings.Buildings
contain floors and floor plans

Area Name*

San Jose

Parent
San Jose | Global/USA/California/

Or

Import Sites

Tech tip

For single area enter the Area Name as the City (example: San Jose) and leave Parent as Global. For multi-level areas create parent and
child areas in the appropriate order.

For example: Country > State > City (USA > California > San Jose).

To import large number of sites, choose Import Sites as highlighted in the above screenshot.

Step 6.  Click the Add button to add the area.

Create building within the area
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Step 1. Under Network Hierarchy, click the Add Site again.

Step 2. From the drop-down menu select Add Building.

Add Building X

Area contains other areas and/or buildings.Buildings
contain floors and floor plans.

Building Name*

Building 4

Parent

San Jose | Global/USA/California/

Address @

150 Tasman Drive, San Jose, California 9513.

Latitude* Longitude*
37.407989 -121.952637
Tech tip

For Latitude and Longitude, enter an Address and select the suggested full address from the drop down and both the fields will be auto
populated.

Step 3. Inthe Add Building pop-up window, type in the Building Name (example: Building 4).
Step 4. Select the Parent area. (example: San Jose | Global/USA/California/)

Step 5. Enter the building address in the text field under Address.

Step 6.  Click the Add button to add the building.

Tech tip

Adding floor is required for setting up wireless network. For more details refer to Catalyst 9800 Non-Fabric Deployment using Cisco DNA
Center Guide.

Process 2: Configure network services and device credentials for network operation

In the procedure below configure the following services that align to the site hierarchy in Cisco DNA Center:

e AAA
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DHCP
DNS
Syslog
SNMP

If the services use the same servers across the entire site hierarchy, you can configure them globally. The inheritance properties

of the site hierarchy makes global settings available to all sites. Differences for individual sites can then be applied on a site-by-

site basis. Then add device credentials to manage scopes of the site hierarchy created in the design.

Add network services

Step 1. Login to Cisco DNA Center and navigate to Design > Network Settings > Network.
Step 2.  Select Global in the navigation panel on the left side of the screen.
Step 3. Click on the +Add Servers button.
Step4. From the Add Servers popup screen check the boxes next to AAA and NTP and click the OK button.
Step 5. Locate the AAA Servers section and fill in the necessary information.
Network Device Credentials IP Address Pools QoS Wireless

Setup network properties like AAA, NTP, Syslog, Trap and Netflow using the " Add Servers" link. Once dev|
deploy using these settings.

AAA Server

Network CIienl/Endpoint

NETWORK

Servers Protocol

[@]ise O aaa O rapius [©]racacs

Network IP Address (Primary)

| 10.4.48.19 x 1 | 10.4.48.19 x +
Change Shared Secret

CLIENT/ENDPOINT

Servers Protocol

Ij ISE O Aaa \Z] RADIUS

Client/Endpoint IP Address (Primary)

| 10.4.48.19 x | | 10.4.48.19 x +
Tech tip

Cisco ISE is not required for the use cases covered in this guide but if already have Cisco ISE you may fill in the Cisco ISE info as the AAA

services.

Step 6.

Fill in the information for the remain network properties:
DHCP
DNS
SYSLOG

SNMP
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e NTP

e Time Zone

DHCP Server

DHCP
10.4.48.10 +

Supports both IPv4 and IPv6

DNS Servere

Domain Name

cisco.local

Primary

10.4.48.10 +

Supports both IPv4 and IPv6

SYSLOG Server

Clsco DNA Center as syslog server

SYSLOG

SNMP Server o

Clsco DNA Center as snmp server

SNMP

NTP Server

O nrp
10.4.48.17 +

Time Zone o

Time Zone

PSTSPDT (PDT)

Message of the day e

Message of the day

Do not override the existing motd banner on the device

Procedure 2. Add device credentials to manage.

These device credentials enable discovery and management for the network. For this procedure, follow these steps:

Step 1. Navigate to Design > Network Settings > Device Credentials, select an appropriate level of the site hierarchy in the
left pane (example: Global for common credentials across the hierarchy).
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Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM 0 Q i &

Network Hierarchy Network Settings Image Repository Network Profiles Auth Template
2Q  Find Hierarchy Network Device Credentials IP Address Pools SP Profiles Wireless
I v ¢ Global
£ CLI Credentials
Name / Description Username Password Enable Password Actions

No Data Available

Step 2. At the top of the CLI Credentials section, click Add, complete the Name / Description (example: 10S Devices),
Username, Password, and Enable Password fields, and click Save.

CLI Credentials

Name / Description *
I0S-Devices

Username *

dna

Password *

>

WARNING: Do not use "admin" as the username for your device CLI credentials, if you are using ISE as your
AAA server. If you do, this can result in you not being able to login to your devices.

-

Tech tip

If you are using ISE as your AAA server, you should avoid using admin as the username for device CLI credentials, which can lead to
username conflicts with the ISE administrator login, resulting in the inability to log in to devices.

Step 3.  Select an SNMP credential type SNMPv2c Read.
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SNMP Credentials SNMPV2C Write | SNMPV3 @ Add

Name / Description Read Community Actions

Step 4. Click +Add and enter the following info:
e Name / Description: ro

¢ Read Community: public

SNMP Credentials X

Name / Description *

Type *
(%) SNMP v2¢ O snup va ro

Community Type * Read Community *

O e e =

Step 5. Click Save
Step 6. Select an SNMP credential type SNMPv2c Write.

SNMP Credentials SNMPV2C Read “ SNMPV3 @ ~ad

Name / Description Write Community Actions

Step 7. Click +Add and enter the following info:
e Name / Description: rw

¢ Read Community: private

SNMP Credentials X
Type * Name / Description *
Community Type * Write Community *

Step 8.  For each of the CLI and SNMP credentials assigned, click all radio buttons next to each assignment created, make sure
to toggle to SNMPV2C Write and select Write.
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CLI Credentials

Name / Description

E Administrator

Username Password Enable Password

rrhnn P

netadmin

@ ~ad

Actions

Edit | Delete

SNMP Credentials

Name / Description

>

SNMPV2C Read || SNMPV2C Write | SNMPV3

Read Community

rrhrx

0 Add

Actions

Edit | Delete

SNMP Credentials

Name / Description

E]

SNMPV2C Read || SNMPV2C Write| | SNMPV3

Write Community

*rhrn

9 Add

Actions

Edit | Delete

Step 9. Click Save and a setting successfully acknowledgment is displayed.

The device credentials to be used for network discovery and management should now be available in Cisco DNA Center.
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Deploy

This section of the guide implements the two use cases mentioned in the Solution Overview section of this document. Cisco
DNA Center is used to automate the deployment of the wired profile created in the Design section of this document.

Process 3: Automate onboarding of a Switch with Plug and Play (PnP)

For LAN Automation deployments, CLI and SNMP credentials is supplied to access and prepare one or more supported PnP seed
devices, such as 9300 Series Switches for access. Plug-and-Play auto discovers switches directly connected to chosen seed device
interfaces and their immediate neighbor switches using Cisco Discovery Protocol, all of which must be running the PnP agent
and have no previous configuration. The credentials supplied allow Cisco DNA Center and seed devices to work together to
configure the discovered devices and add them into managed inventory.

Define Golden image for devices in inventory

Golden Image Onboard Template Create Profile Assign Profile Discover Controller

The software image management capability built into Cisco DNA Center is used to upgrade any devices that are not running a

recommended image version.

Tech tip

In this example switch is upgraded from the default image to 16.9.1.

Use the following steps to apply software updates of images to the devices, by importing the required images, marking images as
golden, and applying images to devices.

Step 1. Login to Cisco DNA Center.

Step 2. Go to Design >Image Repository

Step 3. Click +Import

Step 4. From the Import Image/Add-On dialog, choose a file location, and then click Import.

Import Image/Add-On

Select a file from computer

Choose File cat9k_iosxe.16.09.01.SPA bir

Enter Image URL(http or ftp)*

Imported 102,498,304 Bytes /699,969,133 Bytes. Completed 15

Step 5. Repeat this step for all images that you wish to deploy using Cisco DNA Center.
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Tech tip

Images to be used for device families not yet available in Cisco DNA Center will be listed under the Unassigned category.

Step 6. Under Image Repository, click Show Tasks to verify if the import was successful.
POLICY PROVISION ASSURANCE PLATFORM
ttings v Image Repository Network Profiles

Recent Tasks (Last 50) < Refresh

@ Import ‘ ™ Update Devices ‘ Show Tasks

cat9k_iosxe.16.09.01.SPA.bin
v/ Start Time : Oct 7 2019 18:02:52

Y Filter ‘ Z Refresh Last updated: € pm Duration @ Oh:5m:6s | Type : IMPORT
Family Image Name cat9k_iosxe.16.11.01.SPA.bin
uﬁn Time : Aug 19 2019 09:33:03
Tech tip

If image import fails, next to the failed image in the list click on See why? for more details.

Step 7. Under Image Repository, click Imported Images to expand the list of all the imported images that are pending to be
assigned to a device family.
ttings v Image Repository Network Profiles Authentication Template
e Import ’ M Update Devices = Show Tasks © Take a Tour
Y Filter ‘ < Refresh  Last updated: 6:17 pm
Family Image Name Using Image Version Golden Image
> Imported Images (2) @
> Cisco Catalyst 3650 Switc... Install Mode (16.6.3) 1 5.5

Step 8.  Click on Assign next to the image name need to be assigned.
Family Image Name Using Image Version Golden Image
+ Imported Images (2) @
i cat9k_iosxe.16.11.01.S... 5 16.11.1
a2 @ Verified
Al cat9k_iosxe.16.09.01.S... 0 16.9.1
@ Verified
Step 9. The slide out panel will show the list of device type from CCO based on the image. Check the box next to the Device

Series and click Assign.
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Assign Device Family

Assign cat9k_iosxe.16.09.01.SPA.bin to one or more supporting device series from the list below
v Device Series from CCO
=Q Find

Device Series ~

Cisco Catalyst 9300 Switch

Show 10 entries

Showing 1 - 1 of 1

© Please ensure that you select the right device series for the image. Wrong
selection may cause issues during device upgrade.

Cancel

Step 10. Go to the assigned Device Family and click the expand icon and verify the image imported is available to mark as

golden.
Family Image Name Using Image Version Golden Image Device Role
3 D . 16.11.1
Cisco Catalyst 9300 Switch Install Mode (16.11.1.0.312) 1
Install Mode (16.9.1.0.70) 1 1651
cat9k_iosxe.16.09.01.5PA... 16.9.1
@ Verified a g
Step 11. Click the pencil icon and select the appropriate role, to mark a Golden Image for specific device role.
Family Image Name Using Image Version Golden Image Device Role
) D ? 16.11.1
v Cisco Catalyst 9300 Switch Install Mode (16.11.1.0.312) 1
Install Mode (16.9.1.0.70) 1 L,
cat9k_iosxe.16.09.01.SPA... 16.9.1
@ Verified 0 g

Step 12. Select ACCESS tag.
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Add Device Roles

ALL CORE DISTRIBUTION

P5E
BORDER ROUTER UNKNOWN

ACCESS

Step 13. Verify image is marked as golden and ACCESS tag is selected.

cat9k_iosxe.16.09.01.SPA...
@ Verified

16.9.

1

& | Access

Create Onboarding Templates

Golden Image Onboard Template Create Profile Assign Profile Discover Controller

By default, the Onboarding Configuration project is available for creating day-0 templates. You can create your own custom

projects. Templates created in custom projects are categorized as day-N templates.

Step 1. Login to Cisco DNA Center.

Step 2. From the home page, choose Tools > Template Editor.

Cisco DNA Center DESIGN PoLICY PROVISION

> Imported Images(1) @

ASSURANCE PLATF!

ORM

Network Hierarchy Network Settings Image Repository Network Profiles Auth Template
=Q @ 'mport | ( Update Devices | B Show Tasks | @ Take a Tour
I v & Global
> @HQ Filter > Refresh
> & Whynot
Family Image Name o

Image

Version

Golden
Image

Discovery
Inventory
Topology
Image Repository
Command Runner
License Manager
Template Editor
Telemetry

Data and Reports

Step 3. From the left pane, next to Onboarding Configuration, click the gear icon and select Add Templates.

Cisco DNA Center

=q e

-
A Onboarding Configuration B
&

Add Template

Properties
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Step 4. Inthe Add New Template window, select Regular Template and fill in the following details:

Name

switch-pnp
Project Name Onboarding Configuration (default)
Tags branch-sw-pnp
Device Type(s) Switches and Hubs > Cisco Cat 9300 Series
Software Type IOS-XE
Software Version (Optional)
Tech tip

Tagging a configuration template helps you to search a template using the tag name in the search field. Use the tagged template as a
reference to configure more devices.

Step 5. Under Device Types, click Edit to view the selected device types. Enter the device (example: Cisco Catalyst 9300
Switch) name in Find field to narrow the devices and choose the device types that you want to apply to the template.

Back to Add New Template

Select Device Type(s)

1 Devices Selected

Find Show
9300 X All
M Switches and Hubs

V. Cisco Catalyst 9300 Series Switches
Cisco Catalyst 9300L Switch Stack

Cisco Catalyst 9300 Switch

Tech tip

There are different granularity levels for choosing the device type from the hierarchical structure. The device type is used during
deployment to ensure that templates deploy devices that match the specified device type criteria. This lets you create specialized
templates for specific device models.

Tech tip

Template Editor does not show device product IDs (PIDs); instead, it shows the device series and model description. You can use
cisco.com to look up the device data sheet based on the PID, find the device series and model description, and choose the device type
appropriately.

Step 6.  After choosing the device types, click Back to Add New Template.
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Back to Add New Template

Select Device Type(s)

1 Devices Selected

Find Show
9300 X All

D4 Switches and Hubs

Step7. From the Software Type drop-down list, choose the software type 10S-XE.
Tech tip
If you select 10S as the software type, the commands apply to all software types, including IOS-XE. This value is used during provisioning
to check whether the selected device conforms to the selection in the template.
Step 8. (Optional) For Software Version, enter the software version (example: 16.9.1) and Click Add.
Tech tip
During provisioning, Cisco DNA Center checks to see if the selected device has the software version listed in the template. If there is a
mismatch, the provision skips the template.
Step 9. Select the recently created template from left pane, and in the Template Editor window on the right, enter the
configuration for the template.
Tech tip

We have provided a sample configuration in Appendix A.

Step 10. To save the template content, from the Actions drop-down list, choose Save.

Step 11. To commit the template, from the Actions drop-down list, choose Commit.

Tech tip

Only the committed templates cab be associated with a network profile and to use it for provisioning.

Step 12. From the top-right, click the calculator icon to go to the Form Editor.

Actions v Edit v switch-pnp ®

Template
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Tech tip

All the form fields are drag and drop to rearrange the order.

Step 13. Select a form field (example: Host Name) and check the Required box:

switch-pnp <

Actions v switch-pnp

&
O

Input Form

Preview

Host Name * hostname

st N

D Not a variable Required

Step 14. Fill in the remaining details as following:

Field Name Host Name
Tooltip Text Enter the switch name
Default Value -

Instructional Text =

Maximum Characters 10

Definition of hostname: Data Type String

Definition of hostname: Display Type Text Field
Tech tip

Repeat the above step for all the fields to have friendly names (example: Svlan_mgmt will become Management VLAN). Based on the
variable the data and display type changes. Example for VLAN the data type is integer.

Tech tip

Bind to Source is not supported for Day 0 template, it is only supported for Day 1 template.

Step 15. To test the template, click the button to switch to simulation editor.

Actions v |  switch-pnp
Input Form
Preview
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Step 16. Click New Simulation.

Step 17. Fill in the Simulation input form. (Only partial configuration is displayed in the screenshot below.)

Actions Vv switch-pnp =)

Simulation Input cancel

Simulation Name *

Switch PNP Test Drive

Host Name *

AD1.cisco.com

data_Vian *

100

Voice_Vlan *

101

Mgmt_Vian *

102

AntiHopping_Vlan *

103

Portchannel *

3

Step 18. Click Run, and all the variables in the CLI will now displays the actual value entered in the form fields on the left.

Actions v switch-pnp I =

Simulation Input cancel Template Preview

Simulation Name *

Switch PNP Test Drive

Host Name *

AD1.cisco.com

data_Vlan *

100

Voice_Vian *

101

Mgmt_Vian *

102

AntiHopping_Vlan *

103

Portchannel *

3
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Tech tip

Make sure to commit the template before proceeding for the latest configuration to take affect during device provisioning.

Create Network Profiles for Switching

Golden Image Onboard Template Create Profile Assign Profile Discover Controller

Define the Onboarding Configuration template that you want to apply to the devices. Such templates contain basic network
configuration commands to onboard a device so that it can be managed on the network.

For this procedure, follow these steps:

Step 1. Navigate to Design > Network Profiles.

Step 2. Click +Add Profiles and choose Switching.

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM ° Q HH & (o)

m

Network Hierarchy Network Settings Image Repository Network Profiles Auth Template

— e Add Profile

Routing & NFV
Profile Name ~ Type Sites | Switching
No data to display Wireless
Step 3.  Give a Profile Name, and Click +Add, under OnBoarding Template(s) tab.
Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM O o HH & o) =

Network Hierarchy Network Settings Image Repository Network Profiles Auth Template

Profile Name*

SW-Net-Profile] Add a Network Profile

Templates are created in the Template Programmer.

OnBoarding Template(s) Day-N Template(s)

Profile Type
switching

Attach Template(s)

Q ~dd

Device Type Tag Name Template

No data to display

Step 4. Select Cisco Catalyst 9300 Switch from the Device Type drop-down list.

Step 5. Select the Tag Name (example: branch-sw-pnp) from the drop-down list.

Step 6. Select an onboarding configuration template (example: switch-pnp) from the drop-down list.
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OnBoarding Template(s)

Attach Template(s)

Device Type

Cisco Catalyst 9300 Switch

Day-N Template(s)

Device Tag @

x branch-sw-pnp

Template ~

kwitch-pnp

Step 7. Click Save.

Tech tip

The profile that is thus configured on the switch is applied when the switch is provisioned.

Assign Network Profile to Site

Golden Image Onboard Template Create Profile Assign Profile Discover Controller

Each network profile can have multiple device types and sites assigned. But multiple network profiles cannot share the same
site, even though two different network profile can be assigned different floors from the same site.

Step 1. Choose Design > Network Profiles.
Step 2. Click on Assign Site.

Profile Name ~

SW-Net-Profile

Type

switching

Sites Action

Assign Site Edit | Delete

Step 3.

On the side panel for Add Sites to Profile, expand Site (example: San Jose) and select Building (example: Building 23).

Cisco DNA Center DESIGN POLICY PROVISION

Network Hierarchy Network Settings v Image Repository

ASSURANCE

Network

Add Sites to Profile

v & [ Global (1)
Profile Name ~ Type & [] san Jose (2)
SW-Net-Profile switching > @Building 23(3)
Step 4.
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Discover the controller (PnP Server)

Golden Image Onboard Template Create Profile Assign Profile Discover Controller

For the device to connect with the controller (PnP Server), there are five options:

e DHCP server, using option 43 (set the IP Address of the controller).

e DHCP server, using a DNS domain name (DNS lookup of pnphelper).

e Cisco Plug and Play Connect (cloud-based device discovery).

e USB key (bootstrap config file).

e Cisco Installer App (For iPhone/Android).

In order for devices to call home to plug and play server in Cisco DNA Center, this guide will cover only the first option, DHCP

server, using option 43 for PnP discovery.

Tech tip

For this guide the Option 43 is configured using a Microsoft DHCP server but it can be done using any other DHCP server such as Infoblox
or on a router. For more information on DHCP controller discovery, go here.

Step 1. Go to Microsoft DHCP server to configure using option 43.

p | Scope[10.4.2.0] VLAN 102 Data
b = Scope [10.4.3.0] VLAN 103 Voice
] Scope[10.4.4.0] VLAN 104 Data
] Scope[10.4.5.0] VLAN 105 Voice
| Scope[10.4.6.0] VLAN 106 Data
| Scope [10.4.7.0] VLAN 107 Voice
] Scope [10.4.8.0] VLAN 108 Data
] Scope [10.4.9.0] VLAN 109 Voice
| Scope[10.4.10.0] VLAN 110 Data
| Scope[10.4.12.0] VLAN 112 Data
S o | Scope [10.4.13.0] VLAN 113 Voice
4 [ ] Scope[10.4.48.0] VLAN 148 Data

[} Address Pool

[ Address Leases

I = Reservations

vvvvvvwvww

| Policies
p || Scope[10.4.64.0] VLAN 164 Data

3 DHCP
File Action View Help
e 2E oz BE &
% DHCP ~ ||| Option Name Vendor Value
4§ ad.ciscolocal || 003 Router Standard 10.4.48.1
4 i IPv4 j 006D ] 448
p || Scope[10.4.1.0] VLAN 101 Voice e

¢ 015f

Description | A |
Embedded y
D 044 WINS/NBNS Servers NBNS Add l
[ 045 NetBIOS over TCP/IP NBDD NetBIOS O\I..I:
[J 046 WINS/NBT Node Type (x1=Bnod v
>

3 ASCII:

35 41 31 4E 3B 42 32 3B| S5A1N:B2;
4B 34 3B 49 31 30 2E 34 | K4:I10.4
2E 34 38 2E 32 33 32 3B| .48.232;
44 38 30 Jao|

1. Gotothe Scope Options for the specific VLAN.

2. Under General tab, check 043 Vendor Specific Info.
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3. Replace the IP address with the correct IP address of the Cisco DNA Center (PnP Server).

5A1TN;B2;K4; haxx.xxx.xxx.xxx;J80

Cisco DNA Center IP Address

4. Copy and paste the ascii

option 43 ascii "5AIN;B2;K4;110.4.48.232;J80"

5. Click Apply and OK.

Step 2. Connect a single switch (example: Catalyst 9300) to access layer that’s getting onboarded.

Step 3. (Optional) Connect the console to a new switch and power it on. Once the device boots up, it will get IP address of the
Cisco DNA Center using the option 43 and will do a PnP discovery as below.

--- System Configuration Dialog ---

Would you like to enter the initial configuration dialog? [yes/no]:

Press RETURN to get started!

*0ct 5 02:59:17.440: %PNP-6-PROFILE_CONFIG: PnP Discovery profile pnp-zero-touch configured

*0ct 5 02:59:18.285: ¥CRYPTO_ENGINE-5-KEY_ADDITION: A key named TP-self-signed-882668793 has been generated or import
*Oct 5 ©02:59:18.287: %SSH-5-ENABLED: SSH 1.99 has been enabled

*Oct 5 02:59:18.328: ¥PKI-4-NOCONFIGAUTOSAVE: Configuration was modified. Issue "write memory" to save new IOS PKI d
*Oct 5 02:59:18.370: %CRYPTO_ENGINE-S5-KEY_ADDITION: A key named TP-self-signed-882668793.server has been generated orn
*0Oct 5 02:59:19.441: ¥LINK-5-CHANGED: Interface Vlanl, changed state to administratively down

*Oct 5 02:59:30.000: %SYS-6-CLOCKUPDATE: System clock has been updated from ©2:59:29 UTC Sat Oct 5 2019 to ©2:59:30 U
Oct 5 02:59:30.000: %PKI-6-AUTHORITATIVE_CLOCK: The system clock has been set.

Oct 5 02:59:30.003: %SMART_LIC-5-SYSTEM_CLOCK_CHANGED: Smart Agent for Licensing System clock has been changed

Oct 5 02:59:36.765: %AN-6-AN_ABORTED_BY_CONSOLE_INPUT: Autonomic disabled due to User intervention on console. config
Oct 5 02:59:39.046: %PKI-4-NOCONFIGAUTOSAVE: Configuration was modified. Issue "write memory" to save new IOS PKI co

Oct 5 02:59:49.664: %PNP-6-PNP_DISCOVERY_DONE: PnP Discovery done successfully
%Error opening tftp://10.4.48.10/network-confg (Timed out)

Oct 5 02:59:54.685: AUTOINSTALL: Tftp script execution not successful for Gi@/0.
Oct 5 03:00:36.925: ¥IOSXE_REDUNDANCY-6-PEER: Active detected switch 2 as standby.

Oct 5 03:00:36.923: ¥STACKMGR-6-STANDBY_ELECTED: Switch 1 R®/@: stack_mgr: Switch 2 has been elected STANDBY.
Oct 5 03:00:41.964: %REDUNDANCY-5-PEER_MONITOR_EVENT: Active detected a standby insertion (raw-event=PEER_FOUND(4))
Tech tip

When the device is in process of PnP discovery do not touch the device as it will break the PnP process.
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Day-zero provisioning of switch onboarded with PnP

Golden Image Onboard Template Create Profile Assign Profile Discover Controller

Step 1. Login to Cisco DNA Center.

Step 2. Go to Provision > Devices drop-down and select Plugin and Play

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM
Devices v Fabric Services
- DEVICES (20)
Inventory Focus: Inventory v
| DEVICE TYPE All Routers I Switches APs W
Plug and Play
ices (9)
Y Filter © Add Device Tag Device Actions
> & San Jose (11) 9 D
Step 3. Check the status of the switch to make sure it’s Unclaimed before proceeding.
Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM @ 4
Devices v Fabric Services

Plug and Play Devices (3) Last updated: 12:47 pn

Y Filter ‘ Actions ‘

E] # Device Name Serial Number Product ID Source State Site -

1 FOC2313U0DS FOC2313U0DS C9300-24UX Network N/A

Tech tip

Devices can also be added and claimed using Serial Number and Product ID. On Plug and Play Devices page click on Add and select Single
Device, Bulk Devices or Smart Account Devices and provide information respectively.
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Step4. Select the switch and click on Actions drop-down and select Claim to start the claim wizard.

Plug and Play Devices (2)
Y Filter ‘ Actions ‘
# Claim
Edit
1
Reset
U ! Delete tFo
Tech tip

Before you claim a switch, if the access to the console is available, monitor the configuration in process by Cisco DNA Center. Copy and
paste the following EEM script in the switch console:

event manager applet catchall
event cli pattern ".*" sync no skip no

action 1 syslog msg "$ cli msg"

Step 5.  Assign a site to the device (example: Building 23) and click Next.

Tech tip

This tech tip is only applicable to a scenario where the floor is added to the building. If the network services and credentials
are only applied to a floor and only the building is selected then an error will according while processing the claim request.

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM (]
Devices v Fabric Services
. . . Advanced
o Site Assignment 2 Configuration 3 Configuration 4  Summary

Manage sites in Network Hierarchy

# Device Name Serial Number Product ID Site

1 FOC2313U0DS FOC2313U0DS C9300-24UX I Global/San Jose/Building 23

Step 6.  Select the golden image (example: cat9k_iosxe.16.09.01.SPA.bin) and click Next.
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Tech tip

If an image was marked as golden as shown in Process 3 and Procedure 1, it will be auto assigned in this step.

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM

Devices v Fabric Services

Ad d
Q Site Assignment e Configuration 3 Co:\:;(::a(ion 4 Summary

| FOC2313U0DS FOC2313U0DS - Configuration

FOC2313U0DS
C9300-24UX

Global/San Jose/Building 23

Image:

Select an Image - Ex: Site Inheritance | Image Name (Device Roles)
San Jose | cat9k_iosxe.16.09.01.SPA.bin (all)

Tech tip

Before proceeding with upgrade make sure the switch is in INSTALL MODE and not in BUNDLE MODE.

Step 7. Select the OnBoarding template (example: switch-pnp) that was created in Procedure 2, and click Next.
< > Site Assignment 9 Configuration 3 ég::;::tion 4 Summary

| FOC2313U0DS FOC2313U0DS - Configuration
FOC2313U0DS
C9300-24UX

Global/San Jose/Building 23

Image: '
Select an Image - Ex: Site Inheritance | Image Name (Device Roles)
San Jose | cat9k_iosxe.16.09.01.SPA.bin (all) &
D Skip golden image upgrade
Template:
Select a Template (optional) - Ex: Template Name (Profile Type)
switch-pnp (Switching) )

Tech tip

To give a quick glance at the onboarding template click the eye icon.
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Template:

Select a Template (optional) - Ex: Template Name (Profile Type)
switch-pnp (Switching) (&

Step 8.  Select a switch and enter the provisioning parameters, and click Next.

Advanced
Site Assi t Confi ti S
Q ite Assignmen Q onfiguration e Configuration 4 ummary

Devices
Select devices to fill out provisioning .
parameters switch-pnp
Switch Name *
Find Show
_ AD1-C9300.cisco.loca
=Q Al

V' switch-pnp (1) Management VLAN *

FOC2313U0DS 100

Data VLAN *

101

Voice VLAN *

102

Tech tip

For large number of devices, bulk import using CSV format.

Step 9. Carefully review the summary by expanding each tab, and click Claim.
Step 10. Select Yes to confirm to proceed with the claim request.

Step 11. Now watch the state of the switch change from Unclaimed to Provisioned

1. Unclaimed to Planned

D # Device Name Serial Number Product ID Source ~ State
D 1 FOC2313U0DS FOC2313U0DS C9300-24UX Network Planned
|:] 2 FCW2123L03D FCW2123L03D C9300-24T Network Provisioned
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2. Planned to Onboarding

[:] # Device Name Serial Number Product ID Source ~ State

[:l 1 FOC2313U0DS FOC2313U0DS C9300-24UX Network Onboarding

D 2 FCW2123L03D FCW2123L03D C9300-24T Network Provisioned
3. Onboarding to Provisioned

|:] # Device Name Serial Number Product ID Source ~ State

|:] 1 FOC2313U0DS FOC2313U0DS C9300-24UX Network Provisioned

|:] 2 FCW2123L03D FCW2123L03D C9300-24T Network Provisioned

Tech tip

Hit the refresh if it doesn’t change. Now the device will be available under inventory. In case the status changes to Error, click

on the device name.
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Step 12. Go to Provision > Devices

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM
R
Devices v Fabric Services
=Q_ Find Hierarchy DEVICES (2)
Focus: Inventory v
> & Global (25) DEVICE TYPE Al Routers Switches APs WLCs ] [
Y Filter ‘ © Add Device Tag Device Actions v ©
Step 13. Select the site hierarchy in the left pane.
Step 14. Verify the devices focus is set to Inventory.
Cisco DNA Center DESIGN POLICY PROVISION
O
Devices v Fabric Services
=q Find Hierarc DEVICES (21)
Focus: Inventory v
)
Step 15. Select Switches as the Device Type to narrow down the devices.
DEVICES (14) QG
Focus: Inventory v
DEVICE TYPE [ Al | Routers APs | WLCs ]
Step 16. Verify the newly onboarded switch is in the Inventory.
Y Filter ’ © Add Device Tag Device Actions v @ Last updated: 1:46 pm 3
|:] Device Name ~ IP Address Device Family Site Reachability MAC Address Dev &
D AD1-9300.cisco.local 10.4.79.10 Switches and Hubs .../Building 23 () Reachable 4c:bc:48:f8:9e:80 & ACCES!
|:| AD3-3850.cisco.local f 10.4.95.5 Switches and Hubs .../Floor 3 ‘ Reachable 20:4c:9e:2e:79:00 & ACCES!
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Process 4: Simplified Return Material Authorization (RMA) process.

With hundreds and thousands of devices in an enterprise network, replacing older devices hardware becomes a complex
process considering the steps involved such as identifying the replacement hardware with appropriate software version,
configuration and copy paste errors involved in configuring the potential replacement and such. Cisco DNA Center offers a
complete workflow to seamlessly identify, configure and replace the device hardware in the network.

Tech tip

RMA feature is available starting in Cisco DNA Center release 1.3.1.

Checklist before proceeding with RMA.
o Cisco DNA Center release 1.3.1 is installed.
e The replacement switch has the same exact SKU as the RMA device (faulty).
e Replacement switch is racked and powered up.
e All the connections are moved from the RMA device to the replacement switch.
e Replacement switch onboarded using PnP and is available as an unclaimed device in the PnP inventory.
e License on the replacement device should match the license on the faulty device to be replaced.
e Make sure the switch is in INSTALL MODE and not in BUNDLE MODE.

¢ Faulty switch that needs to be replaced must be in UNREACHABLE state.

Tech tip

For License Check
Run the following command on both the switches (faulty and replacement device) to verify the license:

show license right-to-use

Tech tip

For Mode Check
Run the following command on both the switches (faulty and replacement device) to verify the mode:

show version | begin Switch Ports

Follow the steps below to proceed with the RMA process:

© 2019 Cisco and/or its affiliates. All rights reserved. Page 33 of 45



Step 1. Login to Cisco DNA Center

Step 2. Navigate to Provision > Devices and make sure Inventory is selected as the FOCUS.

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM
I
Devices v Fabric Services
=q Find Hierarchy DEVICES (20)
| Focus: Inventory v |

l v & Global DEVICE TYPE All Routers Switches APs WLCs

Step3. Go to Action > Device Replacement and select Mark for Replacement.

Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM
—
Devices v Fabric Services
=q Find Hierarc DEVICES (20) @ Global

Focus: Inventory v

I v & Global DEVICE TYPE All Rouers | swiches | APs | WiCs | REACHABILITY Al

© Unassigned Devices (9)

V Filter © Add Device Tag Device
> & San Jose ‘ 9 20 ‘
Inventory "
)oi
|E| Device Name « Py Device Family Site Reachability
Software Image ¥
AD1-3850-12X48U.cisco.local f Provision 5 lorted Switches and Hubs -../Building 23/Floor 1 & unreachable
O AD1-3850.cisco.local T Device Replacement> I .../Building 23/Floor 1 (Z) Reachable
Others > =
D AD2-3650.cisco.local ©f .../Building 23/Floor 2 () Reachable
. Mark for Replacement : -
I:‘ AD2-9300 ™ 10.4.79.10 Sup .../Building 23/Floor 1 () Reachable

Tech tip

If the option to select Mark Device for Replacement in not available under the drop-down, then verify the current version of
Cisco DNA Center is at least release 1.3.1. Also notice the selected device is in Unreachable state.

Step4. Click Mark.

Mark for Replacement

After you mark the device for replacement, you can manage them all in the View: Marked for Replacement
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Tech tip

If there is an error Error NCRM10085, it means the software image version is not available in the image repository and needs
to be uploaded and assigned to the switch family (example: Cisco Catalyst38xx switch)

Step 5. From the Inventory drop-down, select Marked for Replacement to view all devices that have been marked for
replacement,
Cisco DNA Center DESIGN POLICY PROVISION ASSURANCE PLATFORM
Devices v Fabric Services
= DEVICES (20) @ Global
Focus: Inventory v
v & Global DEVICE T swiches | aps | wics REACHABILITY Al Unreachable |
© Unassigned Devices (9) Inventory
S Sandoss ¥ Filtel corware lages ice Actions v ®
Provision s
O IP Address "p": Device Family site Reachability
Marked for Replacement l Type
[:| ADT-3850-12X48U. cisco.local 14 10.4.15.6 Supported Switches and Hubs .../Building 23/Floor 1 (2) Reachable
Step 6.

Select the radio button next the Device Name of the faulty device (example: AD1-3850-12X48U).

rocus: Marked for Replacement v
DEVICE TYPE “ Router

Filter Actions v Replacement History

Device Name Platform «

@ Global

Take a To

Serial Number Replacement Serial Number Replace Status
E AD1-3850-12X48U.cisco.ocal WS-C3850-12X48U-E FOC1912v0ZV N/A
Step 7. Click Replace Device from Actions menu to start to RMA workflow.
DEVICES @ Global
rocus: Marked for Replacement v

Take &
V Filter Actions v Replacement History Last upda
Replace Device
Devic o Platform « Serial Number Replacement Serial Number Replace Status
nmark for Replacement
(0 AD1-3 WS-C3850-12X48U-E FOC1912vozZV N/A Ready For Replacement
Step 8.
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Replace Device

With your choosen device, we will now guide you
through a workflow on finding the coppatible
replacement. Once that has been determined, DNA
Center will deploy the image, license and
configurations of your current device to your new
one. Let's get started.

C(”‘Ll‘l

Tech tip

User can choose the replacement device from the list of managed devices or use the Unclaimed tab to add the replacement
device to Cisco DNA Center using Cisco Plug and Play feature.

Step 9. Under Available Replacement Devices, select the Unclaimed device that will replace the faulty device and click Next.

Replace Device

Choose Replacement Device

You've selected to replace AD1-3850-12X48U.cisco.local. Now choose an available replacement from your
inventory below. If you don't see your desired device, simply click 'Add Device' to add a single device or sync with
Smart Account.

Note : We are supporting only like to like devices.

Replacing AD1-3850-12X48U.cisco.local

IP Address 10.4.48.152 Piatform WS-C3850-12X48U-E

Serial Number FOC1912vozZV OS Image 16.6.4

I Available Replacement Devices(1) I

} All Managed Unclaimed 1
Device Name IP Address Status ~ Serial Number Platform
l;\* FCW1919D0U0 Unclaimed FCW1918D0UOC WS-C3850-12X48U-E
Tech tip

Error NCRM11006 indicates the RMA device has not been onboarded using the PnP function so the RMA process will not
continue for that device.
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Error

NCRM11006: There are no archived
configuration for faulty device.

Step 10. Review Summary to make sure the faulty device is being replaced with the right new switch and click Next.

Replace Device

Review

We're almost there. Review the summary below to be sure we've got everything covered. If you need to update anything,

now is the time to do it.

Summary

Replacing

Device AD1-3850-12X48U.cisco.local
Serial Number FOC1912Vv0zVv

Replacing With

Device AD1-3850-12X48U.cisco.local

Serial Number FCW1919D0UO

Installing

OS Image 16.6.4

License

Configuration Dated on Sat Oct 12 2019 14:26:23 GMT-0700 (Pacific Daylight Time)
Tech tip

As shown in the above summary, the Configuration for the RMA device was archived on the mentioned date and time stamp.
This configuration will be applied to the new replacement device.

Step 11. Select Replace Now and click Submit.
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Replace Device

Schedule Replacement

All set to go. We can now begin replacing your old device or you can schedule for later. It's best to replace your device in a

replacement window

() Replace Now ) Schedule Replacement Later

Tech tip

To schedule the RMA for later date and time select Schedule Replacement Later and select the appropriate parameter and
click Schedule. Scheduling a software update was tested successfully.

Tech tip

Error NCRM11005 indicates the RMA device is still in REACHABLE state and needs to be UNREACHABLE. Either have the RMA
device physical unplugged or make changes in configurations to make in unreachable.

Error

NCRM11005: The faulty device should
be unreachable to deploy device
replacement workflow.

Step 12. Click Monitor Replacement Status once you are presented with the following screen.

Replace Device

Done

Great! your device is now ready to be
replaced. After your replacement is installed
and makes contact with DNA Center, the
deployment process will begin at your
scheduled time.

What's Next?

I Monitor Replacement Status I

Step 13. Click In-Progress under Replace Status for the RMA device.
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b 9 obal
T: a =
Focus: Marked for Replacement v -

DEVICE TYPE All Routers Switches
Y Filter | Actions v Replacement History Last updated: 4:24 PM
Device Name Platform » Serial Number Replacement Serial Number Replace Status H

O AD1-3850-12X48U.cisco.local WS-C3850-12X48U-E FOC1912vozv FCW1919D0U0

Step 14. Select the Replace Status tab to monitor the progress of RMA process.

bs
AD1-3850-12X48U.cisco.local (10.4.48.152)
DEVICES
rocus: Marked for Replacement v B 9 Unreachable Uptime: 20 hours 20 minutes
DEVICE TYPE
¢ Run Commands [ View 360
Filter Actions v Replacement His
Detalls Configuration Interfaces
Device Name
Start
O AD1-3850-12X48U.clsco.local
?) \v Claiming(PnP) Replacement Device Runaing
Status Message Task Dispatched
Entry Time 10/12/2019, 16:14:30
Exit Time [}
L3
.J v Updating Cisco Identity Services Engine Int
Status Message
Entry Time 0
Exit Time 0
Tech tip

This process may take roughly 15-30 minutes if there are no errors. Hit the Refresh button to make sure the process has not
failed due to an error.

!) v Checking Replacement Device Reachability Faited

Tech tip

As part of the RMA process Cisco ISE information is also applied to the device. But Cisco ISE is not a requirement for RMA use
case.

?) > Updating Cisco Identity Services Engine lceess 0:00:01

After the RMA process is complete successfully, verify the configuration, image, and license on the new switch are exactly same.
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Operate

Known Caveats

e The RMA process does not pull the configuration from the Onboarding Configuration Template or the Cloud Day-N
Template. The configuration for the RMA devices is saved in the archive and applied to the new replacement device
during RMA process.

e RMA supports replacement of similar devices only. For example, a Cisco Catalyst 3850 switch can be replaced only with
another Cisco Catalyst 3850 switch. Also, the platform ID of the faulty and replacement devices must be the same.

o If the supervisor engine of the replacement device is different from that of the faulty device, the software image pushed
to the replacement device may not be compatible, and the image activation in the replacement device goes to ROMMON
mode.

¢ The RMA workflow supports device replacement only if:

o Both faulty and replacement devices have the same extension cards.

o The number of ports in both devices does not vary because of extension cards.
e Make sure that the replacement device is connected to the same port to which the faulty device was connected before.

e Cisco DNA Center does not support legacy license deployment. Also, the RMA workflow does not register the faulty
device with CSSM, nor remove the faulty device license from CSSM.

e Cisco DNA Center provisions the replacement device with the running and VLAN configurations of the faulty device
available in the archive. If any configuration changes were made to the old device after the latest archive, the
replacement device may not have the latest configuration.

o If the replacement device onboards through PnP-DHCP functionality, make sure that the device gets the same IP address
after every reload, and the lease timeout of DHCP is more than two hours.

e RMA workflow only supports enabling DNA licenses (DNA/Network Essentials and DNA/Network Advantage) on the
replacement device. If the faulty device is running a legacy license (e.g. IP Base, IP Services and etc.), it requires users to
enable the licensing on the replacement device outside RMA workflow, except when licenses on the faulty and
replacement devices match.

e If users choose zero-touch RMA via PnP, RMA could fail if the replacement device gets the DHCP IP address from an 10S
DHCP server initially and image upgrade is involved, since the replacement is very likely to get a new DHCP IP from 10S
DHCP server after reboot.

o If the software image from the faulty device is not available in Cisco DNA Center Image repository, RMA workflow will fail
since it cannot deploy the software image to the replacement device.

For more information you may also refer to Cisco DNA Center User Guide, Release 1.3.1.0.
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Appendix A—Onboarding template example configuration

hostname S$hostname

clock timezone PST -8 0

clock summer-time PDT recurring

ip arp inspection vlan ${data_Vlan}-${Voice Vlan}
I

ip dhcp snooping vlan ${data Vlan}-${Voice Vlan}
no ip dhcp snooping information option

ip dhcp snooping

I

vlan ${Mgmt_Vlan}

name mgmt

I

vlan ${data_Vlan}

name data

vlan ${Voice_Vlan}

name voice

vlan ${AntiHopping Vlan}

name AntiHoppingVLAN

interface Port-channel$Portchannel

description EtherChannel Link to D2-3850_Stack

switchport trunk native vlan ${AntiHopping Vlan}

switchport trunk allowed vlan ${data_Vlan},${Voice_Vlan}, ${Mgmt_Vlan}
switchport mode trunk

logging event trunk-status

logging event bundle-status

load-interval 30

interface range $Sinterface_typel $port_rangel
switchport access vlan ${data_Vlan}
switchport mode access

switchport voice vlan ${Voice_Vlan}
switchport port-security maximum 11
switchport port-security

switchport port-security aging time 2

switchport port-security violation restrict

© 2019 Cisco and/or its affiliates. All rights reserved. Page 41 of 45



switchport port-security aging type inactivity
ip arp inspection limit rate 100
load-interval 30

spanning-tree portfast

ip verify source

ip dhcp snooping limit rate 100

interface TenGigabitEthernetl/1/7

description Uplink D2-3850_Stack

switchport trunk native ${AntiHopping Vlan}

switchport trunk allowed ${data_Vlan},${Voice Vlan}, ${Mgmt_Vlan}
switchport mode trunk

logging event trunk-status

logging event bundle-status

load-interval 30

channel-protocol lacp

channel-group $Portchannel mode active

interface TenGigabitEthernetl/1/8

description Uplink D2-3850_Stack

switchport trunk native ${AntiHopping Vlan}

switchport trunk allowed ${data_Vlan},${Voice Vlan}, ${Mgmt_Vlan}
switchport mode trunk

logging event trunk-status

logging event bundle-status

load-interval 30

channel-protocol lacp

channel-group $Portchannel mode active

interface Vlan${Mgmt_Vlan}

ip address ${Mgmt_ IPAdddr} 255.255.255.0

ip default-gateway ${Default GW}

ip http server

ip http secure-server

ip http client source-interface Vlan${Mgmt Vlan}
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Appendix B— Hardware and software used for validation

Table 1. Hardware and software

Controller (PnP Server) Cisco DNA Center 1.3.1.2

Device to Onboard (PnP Agent) Catalyst 9300 Switch Series 16.09.01
RMA Device (faulty) C3850-12X48U 16.06.04
Replacement Device (Good) C3850-12X48U 16.06.04
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Appendix C—Glossary

Cisco DNA Cisco Digital Network Architecture
Cisco PnP Cisco Plug and Play

RMA Return Material Authorization

SSL Secure Sockets Layer

VLAN Virtual Local Area Network
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